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What Is DASHBOARD for Windows?

Congratulations! You now own the fastest way to work
in Microsoft Windows.

Dashboard for Windows gives you convenient push-button control
over everything you do in Windows.

Dashboard is an on-screen set of buttons, icons, and dials for
working with Windows quickly. You can launch programs from
Dashboard with just the click of a button or a keystroke or two, or
you can print or fax a file by simply dragging it to a Dashboard
icon. A set of miniature screens shows which programs you're
working with; you can switch back and forth among them with a
single click. Glancing at a dial that looks like a gas gauge, you can
check how much memory is left in your computer. Dashboard
even has an alarm clock with a built-in snooze alarm.

And one more thing: you can customize Dashboard for Windows
to fit your personal style. It doesn’t matter whether you prefer a
“luxury sedan” or a “sports car,” Dashboard for Windows will run
the way you want.

Do You Need to Know Anything Special to Work
with Dashboard?

Not really. The only things you need to know are the basic concepts
of Windows such as how to choose from a menu, launch a program,
save a file, and so on. If you haven’t worked with Windows before,
please take a look at your Windows manual before you get started
with Dashboard.
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INTRODUCTION

If You Need Help

Call Hewlett-Packard’s PC Software Hotline if you have any
questions about Dashboard.

United States and Canada: (303) 635-1010

Fax: (408) 720-3618; BBS: (408) 720-3963

Hours: 7:00 a.M. to 5:00 p.m. Pacific Time (Wednesday 7:00 A.m.
to 3:00 p.M.)

United Kingdom: 080 089 8270
Hours: 10:00 A.M. to 6:00 p.M. local time

Germany: 013 081 8726
Hours: 11:00 A.M. to 7:00 p.M. local time

All other countries:
Contact your dealer for software assistance.

Support is also available on CompuServe®. Type GO HPSYS.

What You Need to Run Dashboard for Windows

Hardware: Dashboard can run on any computer that will run
Microsoft Windows 3.1. The computer must have at least 640 K of
internal RAM and 2 MB of extended memory.

Software: Microsoft Windows 3.1.

Hard Disk Space: Dashboard uses 1.5 MB of hard disk space
when installed on your system.

What About a Mouse?

A mouse is recommended, but you can also use Dashboard
without one.



What’s in the Box

e A 31/2" diskette
* Your Dashboard Owner’s Handbook
* A registration card

What’s New in Dashboard 2.0?

The fastest way to work in Windows is now even faster. We've
added a host of new features to give you greater flexibility to work
the way you like. You can now run Dashboard vertically, or
display your Quick Launch buttons, Printer Manager, and
Program Groups as toolbars anywhere on screen. We've also added
a new Calendar panel to help you manage your busy schedule. And
the new minibuttons and sizing tools, as well as the new font
options, give you more control over the size of Dashboard.

New user-defined Hotkeys allow you to blaze through work,
launching programs or switching screens with just a keystroke.
Or, for added convenience, designate any program a Sticky App,
and its window will always appear on screen.

DOS experts will find the new DOS Command Window in the Run
dialog box to be an indispensable time-saver. Enter DOS
Commands right from Dashboard, without ever leaving
Windows. Copy files, list directories, and manage programs. You
can even select programs from the DOS Command Window and
drag them to Dashboard to launch.

With Dashboard 2.0, launching programs has never been easier.
Drag programs from open groups, program menus, or the File
Manager and drop them onto any of Dashboard’s extended
screens to launch. Or, drop a program onto the Quick Launch
panel to instantly create a Quick Launch button. You can also save
the arrangement of your open program icons, and designate the
layout as a startup layout. Then, whenever you open Dashboard,
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those programs will be instantly launched and placed in the same
location on the extended screens.

Keep a close eye on the status of your disk drives with the new
Drive Watch Panel. And to help you see your remaining resources,
display the Resource Gauge as a Bar Gauge.

Along with these new features, Dashboard’s performance has
also been improved, resulting in quicker startup time and better
management of resources. And just for fun, we’ve added more
custom backgrounds and colors.
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Installing DASHBOARD for Windows

If you purchased your computer directly from Hewlett-Packard,
or one of its subsidiaries, Dashboard may already be installed
on the hard drive. In that case you can skip these installation
instructions.

To install Dashboard:

1. Insert Dashboard disk into drive A.

2. Run Windows 3.1.

3. Choose Run from the Program Manager File menu to see the
Run dialog box.

4. In the command line box, type
a:\setup
5. Click OK to start the installation.
A dialog box will open showing the default directory where
Dashboard will be installed. To install it in a different
directory, type a new path name in the Install to box.

6. Click OK to install Dashboard on your system.

7. When the installation has been completed, click OK to exit
Dashboard installation and return to Windows.

8. To open Dashboard, open Dashboard for Windows
Program Group and double-click Dashboard icon.

2 INSTALLING DASHBOARD FOR WINDOWS



Control anel

"

Drivers

Installing Sound

Some Dashboard features such as the alarm clock use sound.
Your Dashboard disk includes a driver program from Microsoft
Corporation for generating sounds, but you do not have to install
the driver if you don’t want the sounds (although the driver is nice
to have and is recommended).

If you've previously installed a sound driver program for Windows

prior to installing Dashboard, you don’t have to install this new

driver. Dashboard software will already be able to use its sound
options. But if you haven’t installed a sound driver for Windows
before, here’s how to install the new driver on your Dashboard
disk:

1. With the Dashboard disk still in drive A and with Windows
running, open the Control Panel. It will usually be in the
program group Main.

2. Double-click the Drivers icon (not the Sound icon).

3. Click Add.

4. Select Unlisted or Updated Driver and click OK.

5. You'll see the Install Driver dialog box. Type

a:\
in the space provided, and click OK.

6. You'll then see the Add Unlisted or Updated Driver dialog box
with Sound Driver for PC-Speaker selected. Click OK.
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7. Next, you'll see the Speaker Driver dialog box. Use the different
controls to customize the volume and duration of the sound.
Click the Test button to hear a sample.

8. Click OK when you're satisfied with the sound.
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Introductory DASHBOARD Tour

System menu Program Show Program
Task menu miniwindow Menu button Minimize button
Title bar imi
Layout menu Resource Gauge Drive Watch Maximize button
Help button
Program
menu
Customize
button
Alarm Calendar Program Memory Default Scroll About
Quick clock icon meter Qrinter arrows [ poapon
Launch Extended Screen light )
butt screens selector Printer )
uttons Minimized . Manager  Sizing border
. Warning
icon .
indicator
Dashboard Features
Feature Description
About button Shows product information about Dashboard.
Alarm clock Shows the date and time set on your computer. Double-click to add or edit an
alarm. Change the clock face with the Customize button.
Calendar Today’s date is highlighted. Click any date to set an alarm.
Customize button Click once to see the Customize dialog box where you can personalize

different features of Dashboard software to suit you best.

Default printer light The green light indicates the default printer. Click to change the default
printer.

Drive Watch This list displays all drives currently selected for Drive Watch. Icons indicate
the type of drive. Free disk space is shown in kilobytes. Double-click panel to
select drives for Drive Watch.

Extended screens These represent the multiple full-screen views available with Dashboard.
Each extended screen represents a full-screen view. The active extended
screen shows what you currently see on your actual computer screen. You can
have three, five, seven, or nine extended screens.
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Feature

Description

Help button

Layout menu

Maximize button

Memory meter
Minimize button
Minimized icon

Printer Manager

Program icon

Program menu

Program miniwindows

Quick Launch buttons

Resource Gauge

Screen selectors

Click to change the cursor to a question mark. Then click any portion of the
Dashboard window to get help about that item. Double-click to see an index
of topics.

You can name, save, and load custom Dashboard layouts or edit existing
layouts.

Extends the Dashboard window to its full width when horizontally
displayed, or to its full height when vertically displayed. Click again to return
to previous size.

Shows the amount of system memory available for use.
Click to reduce the Dashboard window to an icon.
Much like a miniwindow, this represents a currently minimized program.

Click once to see the full name and description of the printer. Double-click to
see the Printer Configuration dialog box. Printers can be easily configured
from the Dashboard window. To print or fax a file, simply drag a file from
the File Manager onto any printer icon. To change the order of the printer
icons on Dashboard, drag and drop them to new positions.

Identifies the program being represented by this miniwindow. You can show
or hide the icons.

Shows your program groups. Click on a program group button to see the
menu of programs within that group. To launch a program, click the program
icon or drag it to an extended screen. To change the order of the group
buttons on Dashboard, drag and drop a button to a new position.

Double-click a program group button to see the group as a window. Programs
within the group are displayed as icons. Add new programs to the group, drag
programs from other groups, or create a group within a group.

Each miniwindow represents a program that is currently running. The
miniwindow’s location on Dashboard’s extended screen corresponds to the
location of the real program window on your computer screen. Dragging the
miniwindow moves the real program window on screen and vice versa.

Click once or drag to an extended screen to launch your favorite programs.
Create custom Quick Launch buttons using the Customize dialog box. To
rearrange the buttons, drag and drop them to new postions.

Shows current Windows System Resources available. Double-click to see
detailed system information, including disk usage, CPU type, and more.

Click to activate an extended screen or to switch to a different extended
screen.
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Feature

Description

Scroll arrows
Show Program
Menu button
Sizing border

System menu

Task menu

Title bar

Warning indicator

Click to see items not visible in the Dashboard window.

Toggles between showing and hiding the Program menu.

Drag the top or bottom borders to change the height of the Dashboard
window. Use the side borders to change the width.

Has all the commands from the Windows System menu plus special com-
mands to switch to other Dashboard menus and features.

You can switch between currently open programs, run new programs, search
for a particular program, or close all programs other than Dashboard and
the Program Manager.

Displays caption and can show date and time as well. Grab here to drag the
entire Dashboard window.

Blinks when Windows system resources or memory get critically low. Click
once to see a list of currently open programs.

Hotkeys and Drag Racing—Quick Tips for
Using Dashboard

Like a hot rod or dragster, Dashboard has been designed to help
you get where you want to go as fast as possible. Here are a few
quick tips on some of Dashboard’s latest features that will help
you to work even faster.

Dragging

If you would rather drag an icon than type in a long and
complicated file path, then Dashboard 2.0 is the program for you.
Dashboard has been designed to support drag and drop in almost
all of its features.

For example, to launch a program, simply drag its icon from the
Quick Launch panel, the Program Menu, an open Dashboard
group, or the File Manager to any of Dashboard’s extended
screens. If you're using the DOS Command Window in the
Dashboard Run dialog box, select a program’s command line

8 CHAPTER 2: INTRODUCTORY DASHBOARD TOUR



and drag it to any extended screen to launch. To create a new
Quick Launch button, drag the program icon to the Quick Launch
panel. If you don't like the order of the buttons on the Quick
Launch panel, simply drag the icons to rearrange them. To print
a file, just drag it from the File Manager to the Printer Manager.
Use the drag-and-drop feature to save yourself as much time

as possible.

Hotkeys

Several of Dashboard’s features can be used with designated
Hotkey or mouse click sequences. Use the Customize dialog box
{Chapter 4) to set up Hotkeys and mouse clicks that you will easily
remember. Then, while you're working in a program, you won’t
need to hunt down the Dashboard window to take advantage of its
features. Just enter your custom Hotkey or mouse click sequence,
and you’re off and running.

For example, using the Extended Screens Preferences command
(Chapter 4), you can designate a Hotkey for each extended screen.
Then, to switch screens, simply enter the Hotkey for the screen you
would like to go to, and Dashboard will automatically switch

you there.

Sticky Apps

Sometimes, you will want to have a certain program icon on screen
at all times, such as the one for your e-mail application. Use the
Extended Screens Preferences (Chapter 4) to designate your e-mail
program a Sticky App. Then, regardless of which extended screen
you are working in, the e-mail program will always remain on
screen.

Startup Layouts

Often, you'll work with the same programs over and over again.
Rather than having to open each program individually every time
you work, try saving them all in a layout. Then, to open all the
programs at once, simply load the layout. To save even more time,
designate your favorite layouts as startup layouts. When you
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launch Dashboard, all startup layouts will be loaded
automatically, and all programs that are part of those layouts
will be instantly opened and placed in their same locations on the
extended screens. See “Working With Layouts” in Chapter 4.

Shell Program

The shell is the program that opens when you run Windows, and
closing the shell closes Windows. The default Windows shell is
Program Manager, but you can easily designate Dashboard as
your shell by using Dashboard Preferences in the Customize
dialog box. See “Dashboard Preferences” in Chapter 4.

Run Dialog Box With DOS Command Window

Double-click on the Task menu or choose Dashboard Run... to see
the Run dialog box. At the bottom of this dialog box is the DOS
Command Window. Enter DOS commands right from Dashboard,
without leaving Windows. You can copy files, list directories, and
manage programs. To run a program, either type the program
name from the correct directory and press Enter, or select the
program’s command line and drag it to an extended screen on
Dashboard.

Dashboard's Task Manager

Dashboard automatically replaces the Windows Task Manager
with its own. (Use the Customize button to disable this feature. See
“Dashboard Preferences” in Chapter 4.) To see the Dashboard
Task Manager, double-click on the Windows background, or press
Ctrl + Esc. Use the Task Manager to switch to open programs,
close selected programs, tile or cascade your program windows, and
to see specific information for each program.
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Using DASHBOARD

On screen, the Dashboard window behaves like any other
program window. Clicking Dashboard activates it and places it in
front of the other windows on screen. Likewise, clicking on another
window will send Dashboard behind it. If you prefer, you can set
Dashboard to always appear in front of the other program
windows on screen, regardless of which one is active. See
“Dashboard Preferences” in Chapter 4.

As an alternative, use the Hotkey or mouse shortcut to toggle
between placing Dashboard in front of or behind the other
program windows. Hotkeys are user-defined keyboard
combinations that activate various Dashboard features. The
Hotkey and mouse shortcut for activating Dashboard

can be changed in the Dashboard Preferences dialog box. See
“Dashboard Preferences” in Chapter 4. The default settings are
listed below.

When the Dashboard window is behind other programs, activate
it—that is, place it in front of the other programs on screen—using
any of the following methods:

* Press the keyboard Hotkey shortcut. The default setting for this
is F12, but you can designate a new key using the Customize
button. See “Dashboard Preferences” in Chapter 4.

* Click the mouse shortcut. The default setting for this is left and
right buttons.

* (Click anywhere on the Dashboard.

Using the Mouse

To click an item on screen, move the mouse pointer over the item,
press the button down and release it quickly. To double-click, do
this twice. To grab an item, press the button and hold it down. To
drag, first grab, then move the pointer to the new location and
release the button.
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Moving and Resizing the DASHBOARD Window

¢ To move the Dashboard window, put the mouse pointer on the
title bar, then drag.

* To minimize or maximize the Dashboard window, click the
Minimize/Maximize buttons or choose Minimize or Maximize
from the System menu.

* Close the Dashboard window by double-clicking the System
menu button or by choosing Close from the System menu.

¢ Show or hide the Program menu by clicking the Show Program
menu button or by choosing Show Programs Groups from the
System menu.

Double-click the Dashboard icon or choose

Move Restore from the System menu to return the
Eize Dashboard to its previously saved size.
Minimize When you select Minimize, the Dashboard
Maximize window stays open, but it is reduced to an
icon on the screen.

Close Alt+F4
Switch To... Ctrl+Esc
Task Menu Alt+T
Layout Menu Alt+L

v Show Programs Menu

Maximize expands the Dashboard window to its largest possible width
if horizontally displayed, or to its largest possible height if vertically
displayed. When Dashboard is maximized, clicking the Maximize
button will return the window to its original size.
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To adjust the height of Dashboard, move the cursor to the top or
bottom border of the Dashboard window. The cursor changes to a
sizing arrow. Click and drag to change. Notice that compressing
Dashboard vertically will change the appearance of some of the
panels. For example, the Extended Screens may no longer display
the Screen Selector buttons. To switch between views, you would
now double-click on the screens themselves or use the screens’
Hotkeys. See “Extended Screens Preferences” in Chapter 4.

To adjust the width of Dashboard, use the side borders of the
Dashboard window. Notice that compressing Dashboard
horizontally may cause some panels (such as the Printer Manager
or Quick Launch panels) to be too small to show all of their items.
If this occurs, scroll bars appear that allow you to scroll among
the items

To resize individual Dashboard panels, such as the Quick Launch
panel or Printer Manager, hold down the Shift key and move the
cursor to the edge of the panel. When the cursor changes to a sizing
arrow, click and drag the gray border that appears. The panel shows
as many items as possible in the space you've defined.

Use the side borders to change

Use the top and the width of Dashboard.
bottom borders to
change the height of
Dashboard.

Hold down the Shift
key to resize
individual panels.
DRIVING TIP: As you resize Dashboard, panels toward the left side
will have priority over panels toward the right. For example, if the
Quick Launch panel is to the left of the Printer Manager, the Quick
Launch panel will show all Quick Launch buttons before the Printer
Manager shows all printers. To control which panels show all items
first, use the Customize dialog box to reorder the panels on the
Dashboard, placing the panels you need most often on the left side.
See “Rearranging Items in the Dashboard Window” in Chapter 4.
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Displaying DASHBOARD Vertically

Customize button

To display Dashboard vertically:
1. Click on the Customize button to open the Customize dialog box.

2. Choose Dashboard from the list of items to customize.

3. In the Preferences section, select Vertical as the window
orientation and click Done.

Preferences

Customize - DEFAULT.CFG
Help

Choose an Item to Customize Dashboard Prelerences
or Drag an ftem to Move

g Program Menu

o -
g'uol :: ,l(_::::::a' [] pashboard always in front

. X Uge Dashboard as Windows Shell JJJ
E}|Extended Screens X Replace Windows Task Manager
ﬁﬂf:outcex Show icong in menus and screens
ﬁPnnlel Manager Title Bas Display

[Eandald]

Minimized Display

Eandald]

O Vertical

You move and size Dashboard exactly the same way whether it is
displayed vertically or horizontally. As you resize, certain panels
will adjust to fit in the space you've defined. For example, the
extended screens may not display the screen selectors if there is
not enough room. In this case, simply double-click the screens
themselves to switch back and forth.

DRIVING TIP: To make Dashboard even smaller, try hiding items

or displaying panels as toolbars. See “Working With Toolbars” later
in this chapter, and “Dashboard Preferences” in Chapter 4.
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Using Help

Click the Help button and the cursor becomes a question mark. Put
the question mark on any item and click to see specific help for that
item. You’'ll see a Help dialog box.

Double-click the Help button to see a list of topics. Scroll through
the list and click a topic to see more information.

Help button

Click Search to see the index of topics. Click Contents to see a table
of contents of topics.

Choose How to Use

Help from the Help

menu for instructions
Using Hely on how to use the Help

Intiaducing Dashboard system itself.

Cashboard Panels

Procedures

Checking Your Rescurces
Customizing Dashboard

Changjng the Pragram Menu
Creating Quick aunch Buttons
Customizing the Alarm Clock,
Customizing the Printer Manager
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Help buttons are also included in dialog boxes. If you need to see
more information or instructions from within a dialog box, simply
click the Help button.

Change lcon

Current lcon:

If you clicked the Help button to change the cursor into a
question mark, it will remain a question mark until you click an
item. Moving the cursor off the window changes it back to an
arrow, and you can then use the cursor to work with other
programs. However, as soon as you return it to Dashboard, the
cursor will appear as a question mark until you click an item.
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Using the Keyboard

You can operate Dashboard from the keyboard as well as with the
mouse. Every feature of Dashboard is available from the keyboard.

Press this key

To do this

F12

Alt-(character)

Alt-Spacebar
Alt-Tab

Ctrl-Alt-Arrow keys
Ctrl-Fé

Arrow keys
(up/down/left/right)

End

Enter

Esc
Home
Shift-F8

Shift-Tab
Spacebar
Tab

Bring the Dashboard window to the front of other windows. You can change the
key combination or mouse click sequence with the Customize button. See
“Dashboard Preferences” in Chapter 4.)

Choose a button or menu command that has its selection character underlined.
For example, if a button is labeled Add, the letter A is the letter for selecting with
the Alt key; pressing Alt-A is equivalent to clicking the button. (If a button is in a
dialog box, you can just press the A instead of Alt-A, although Alt-A will work too.)

Show the System menu.

Cycle through the open programs running under Windows. Use this option to
bring the Dashboard window to the front.

Move items in a dialog box list.

Move between Dashboard Windows (e.g., Main Window, Toolbars, Customize
dialog etc.).

Highlight items in menus and in groups within a dialog box. If you use Tab to
highlight an item in the Dashboard window, using the arrow keys will cycle
through individual components of the items.

Move to the last item in a list.

Equivalent to double-clicking the highlighted item. In a dialog box, equivalent to
clicking OK.

Exit a menu or cancel out of a dialog box.
Move to the first item in a list.

In the DOS Commands box to switch into keyboard focus and then cursor keys to
move the focus.

Tab key functions in reverse.
Select chosen items in the Dashboard window. Equivalent to clicking the mouse.

When the Dashboard window is in front, use the Tab key to cycle through and
change the keyboard focus on different sections of it. When a dialog box is active,
the Tab key cycles through groups in it. Use arrow keys to choose items within

a group.
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Launching Programs

Click a button on the
Quick Launch panel or
drag it to the Extended

Screens to launch a
program.

You have several ways to launch applications from Dashboard.
From the File Manager or from program group windows, or
Program Menu, or Quick Launch, simply drag a program icon to
Dashboard’s extended screens to launch it. Or, you can create a
set of Quick Launch buttons for the programs you use most often.
You can also launch programs from the Program menu, as part of a
layout, or with the Run command. Use whichever method you find
most convenient.

Use the scroll arrows to gain access to
the Quick Launch buttons if you have
more than will fit on the screen.

Using Quick Launch Buttons to Launch Programs

You can create as many as 32 separate Quick Launch buttons.
To instantly create a Quick Launch button, grab a program file
(such as cardfile.exe) from the Windows File Manager, an open
Dashboard program group, or the Dashboard Program menu
and drag it to the Quick Launch panel.

Or, you can use the Customize button to create Quick Launch
buttons. Choose the minibuttons option to save space, or labeled
buttons to see the title as well as the program icon. You can display
the Quick Launch panel as a floating toolbar, separate from the
Dashboard window. You can also add, edit, delete, or reorder
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programs in the Quick Launch panel. See “Creating Quick Launch
Buttons” in Chapter 4.

You can set up a Quick Launch button to load a data file at the
same time it launches the program. To do this, enter the name of
the data file as part of the command line in the Quick Launch
Preferences dialog box. For example, to launch Microsoft Word for
Windows and a data file named MEMOS.DOC at the same time,
enter the full path name and file name for MEMOS:

\winword\doc\memos.doc

File names must include extensions.

DRIVING TIP: To instantly create a Quick Launch button that

will automatically load a data file when it launches the program,
simply drag the data file (for example, MEMOS.DOC) from the
Windows File Manager to the Quick Launch panel.

@ DRIVING TIP: To resize the Quick Launch panel, hold down the
Shift key and move the cursor to the edge of the panel. When the

cursor changes to a sizing arrow, click and drag the gray border
that appears. The panel shows as many Quick Launch buttons as
possible in the space you've defined.

DRIVING TIP: Clicking a Quick Launch button will launch its

program in the same extended screen you are presently in. Drag
the Quick Launch button to another extended screen if you would
like the program to open there. To rearrange the Quick Launch
buttons, simply drag them to new locations. To make a copy of a
Quick Launch button, hold down the Ctrl key as you drag.
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Drag and Drop Program Launching

You can launch a program by simply dragging its file or icon onto
the extended screens. You need not drag the program to the
currently active screen, it will open on whichever screen you
place it.

To launch a program directly from the File Manager,
simply drag the program file to an extended screen.

You can also drag programs from other Dashboard panels to an
extended screen to launch.

Drag program icons from the program groups to an
extended screen to launch.

You can also drag programs from the Quick Launch panel. This is
especially beneficial if you want to launch a program in a different
extended screen from the one you are working in.

DASHBOARD OWNER’S HANDBOOK 21



To launch a program
from this window,
simply click the
program name.

This row of buttons is
the Program menu.

Launching Programs from the Program Menu

The Show Program
Double-clicking a Menu button toggles
program button between showing and
shows its group as a hiding the Program

window.

To launch a program from the Dashboard Program menu, find its
corresponding group button on the menu. Each button on the menu
corresponds to a program group currently available in Windows. If
you have a lot of groups, you may have to use the scroll arrows next
to the buttons to find the one you want. Click the program group
button to see all of the programs within that group. The programs
within that group are shown as icons followed by text description.
Choose the program you want to run.

DRIVING TIP: Use the Customize button to organize the Program
menu. Rearrange the order of the program groups, add or delete a
group, hide a group, or change the color of a group’s corner tabs.
See “Changing the Program Menu” in Chapter 4.

DRIVING TIP: Usually, the programs you launch will be opened
in the currently active extended screen. To launch a program in
another extended screen, simply drag the program from the
Program menu to the extended screen where you would like it
to be.
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Using the Layout Menu to Launch Programs

To see the Layout menu, click the Layout menu button, or choose
Layout menu from the System menu.

Manage Layouts.,.
Save Layout...

Load Sample Layout
Custom Layout 1
Custom Layout 2
Custom Layout 3

The Layout menu

The Layout Menu displays a list of all the previously saved layouts.
Choose from this list. All the programs saved as part of that layout
will now be launched and placed in the same positions on the
extended screens as when the layout was saved.

The Load Layout command will launch all programs that were
saved as part of that particular layout. If you would like a specific
file or document to open with a layout, you must first include that
file or document name as a command line parameter for the
program it is associated with, and then save the layout. To learn
more about editing command line parameters, see “Working With
Layouts” in Chapter 4.

Most programs saved as part of a layout will be launched exactly as
they were. Thus, if a program was minimized when saved as part
of a layout, it will be minimized when that layout is opened.

DRIVING TIP: You can designate any layout a startup layout.
When you first launch Dashboard, it will automatically load all
startup layouts. To learn more about designing custom layouts, see
“Working With Layouts” in Chapter 4.

DRIVING TIP: You can also use the alarm clock to launch

programs. To learn more about setting an alarm, see “Setting an
Alarm.”
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Launching Programs With the DOS
Command Line

To launch programs using the DOS command line, choose
Dashboard Run from the Task menu or double-click on the Task
menu button. To open the Task menu, simply click the Task menu
button on the Dashboard, or choose Task menu (Alt-T) from the
System menu. The Task menu shows all the currently running
programs in alphabetical order. Choose Dashboard Run to see the
Dashboard Run dialog box.

Program Hotkeys are listed here. To create a Hotkey
for a program, use the customize button. See “Quick
Launch Preferences” in Chapter 4.

= CorelDRAW! - UNTITLED.CDR.  Ctrl + Alt+ €
ile Manager Ctel + Alt+ F
Microsoft Excel Cirl + At + X

To launch a program — Dashboard Run...
using the DOS Close All Programs Choose Close All
command line, choose Update Screens Programs to close all
Dashboard Run from Dashboard currently running
the Task menu. The programs, with

Dashboard Run dialog
box appears.

the exception of
Dashboard and
Program Manager.

24 CHAPTER 3: USING DASHBOARD



Enter the command line
for the program to run.
Or enter DOS com-
mands here to see the
results showing up in
the DOS command
window. Use DOS
commands to locate the
program’s command
line.

Check this box if you
want the program to
be minimized when
you open it.

DOS command window

Click here to launch the program. If the
program is a DOS application, a DOS
window opens with the program.

Click here to see the
command history.

"6;gﬁﬂgafdpﬁh““m.m'"

Command Line:

[C:\Windows\Winfile.exe

]— —{1 Run Minimized

— Use the Browse button
to find the program’s
location and file name.

ADDRESS DTF 11776 03,2493 1:26p
PKUNZIP EXE 22022 10-01-89 1:02a
CCREMOTE <DIR> 02-08-93 7:41p
SYNCHAST DA 316 03-24-93 1:41a
AUTOEXEC BAT 174 02-/14-93 4:17%a
PLAYER  GRP 4510 04-20-93 4:11p
ADDRESS IDX 9728 03,2493 1:26p
ETIDEMO <DIR> 03-25-93 8:58a
40 file(s) 112179 bytes
1566720 bytes free
[C:N]ed windows
[C:\WINDOWS]_

The command history shows the last twenty command lines that
have been entered. If the command line you want to enter is
already listed here, you don’t have to retype it. Simply click to
select it.

Use the DOS command window to enter DOS commands right
from Dashboard, without ever leaving Windows. You can search
directories, copy files, and run programs using DOS commands you
are already familiar with. Use the up and down arrow keys to cycle
through a history of the latest commands. To run a program, either
type the program name from the correct directory and press Enter,
or select the program’s command line and drag it to an extended
screen on Dashboard.
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Using DASHBOARD’s Task Manager

When you launch Dashboard, it automatically replaces the
Windows Task Manager with its own. (Use the Customize

button to disable this feature. See “Dashboard Preferences” in
Chapter 4.) To see the Dashboard Task Manager, double-click the
Windows background, or press Ctrl-Esc. Use the Task Manager to
switch to open programs, to close selected programs, and to tile or
cascade your program windows.

Task List:
The task list shows all —]

. CorelDRAW! - UNTITLED.CDR
currently running

L% Microsoft Excel

programs that are not Quicken 2 for Windows
minimized. Click here to see the Application
ized Applications: Task Information dialog box for
These programs are Amaze Daily Planner - SAMPLE.DP the selected program.

currently running as
minimized.

Click here to close the selected
programs in the task list or
minimized applications list.

Click here to activate
the selected program
in the task list

or minimized
applications list.

Arrange Icons rearranges all
minimized icons in every
extented screen.

Cascade resizes all program windows in the
extended screens so that they appear to stack
neatly, one in front of another.

Tile resizes all program windows in the extended
screens so that they are all visible on screen at the
same time, side by side.

The Application Task Information dialog box shows detailed
information for the selected program.

Application Task Information

Application:
CAWINDOWSA\WRITE.EXE
Task Memory Uszed [bytes):

106560 Write - SYSINLWRI
47680  Write - README WRI

154240
Common Memory : 121696

Total Application Memary: 275936
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Managing Your Program Groups

Double-click a
program group to
see it as a window.

One of the most powerful features of Dashboard is its flexibility in
working with program groups. Unlike Windows Program Manager,
with Dashboard you can drag program icons from their group to
the extended screens to launch. You can even create groups within
a group.

Program groups are displayed right on the Dashboard in the
Program menu. Use the Customize button to change this menu by
adding new groups, reordering or hiding existing groups, changing
a group’s color tabs, or even displaying the whole menu as a
resizable toolbar anywhere on screen. See the following section
“Adding a New Program Group” and the section “Changing the
Program Menu” in Chapter 4.

ain (Dashboard Group)

File Window Help

File: Manager Contral Farel Print Manager
s =
Windows PIF Editor Read Me

Setup

The programs within a group are shown as icons in their Program
Window. Notice that they are arranged in the same order as they
are in the Program Manager. To launch a program from the
window, double-click its icon or drag it to any of Dashboard’s
extended screens.
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Adding a New Program Group

When you first start Dashboard, all of the program groups
created with Windows Program Manager are displayed as buttons
in the Program menu on the Dashboard. Use the Customize
button to create new program groups right from Dashboard.

To create a new program group:

1. Click the Customize button to open the Customize dialog box.

2. Select Program Menu as the item to customize.

Customize - DEFAULT.CFG

File Help

Choose an Item to Customize Program Menu Pieferences
or Drag an Item to Move .

Dashboard
&9 Program Menu

Program Groups
[Drag an item to reorder list)
HWan

%4 Quick Launch gt;t':nt:s:ones
H Clock/Calendar StartUp

¥ Extended Screens Applications

) Tools
;ﬁ Resources Word Processing
ﬁPlimer Manager Word for Windows 2.0

[ Show 2nd Row of Text
BJ Show Color Keys

i
Click the New button.

3. Click the New button to open the New Program Group dialog box.

4. Enter the name of the new group along with the group file
(optional). Select a color tab for the group, and click OK.

Group D ipti L ntitled|

Group File:

C ]
Color Key: D -
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NOTE: Program groups created in Dashboard use the same group
files as those created in Program Manager. If you are running both
Dashboard and Program Manager at the same time, and you use
Dashboard to make changes to a program group, the changes will
automatically be reflected in Program Manager. However, if you
make a change using Program Manager, it will not be reflected in
Dashboard until you click the Reread from Program Manager
button in the Program Menu Preferences screen, or until you exit
and reopen Dashboard.

Moving or Copying Programs Within Groups

To move a program from one group to another, open both program
windows from Dashboard. Drag the program icon from
one window to the next.

File Window

=

Print Manager

&

Windows Setup

To copy a program so it will be in two groups, select the program’s
icon, then hold down the Ctrl key while dragging the icon to the
new window. Both program windows will have a copy of that
program.

DRIVING TIP: The shell is the program that opens when you use
Windows, and closing the shell closes Windows. The default
Windows shell is Program Manager, but you can easily designate
Dashboard as your shell by using the Dashboard Preferences
command in the Customize dialog box. See “Dashboard
Preferences” in Chapter 4.
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DRIVING TIP: Program groups interact with the rest of the
Dashboard panels. To add a program from the Quick Launch
panel to a group, drag its icon to the group window. Or, drag a
program icon from a group to the Quick Launch panel to instantly
create a Quick Launch button. Similarly, to launch a program,

drag its icon from the program group window to an extended
screen.

Creating a Group Within a Group

All of the existing program groups are displayed as buttons in the
Program menu on the Dashboard.

1. Double-click the button for the program group you would like to
open. This program group’s Program Window appears.

2. To create a new group within this existing group, choose New
Group from the File menu.

Main (Dashboard Group
Eilc__Window__Help

=
fad

File Managet Control Panet Print Managat

Description: [New Group

4
‘Windows
Setup Group File: | 1 13

3. In the Group File box, type the description you want to appear
below the new group’s icon.

4. Click OK. You don’t have to enter a file name. Dashboard will
assign a group file name automatically.

The new group will now be shown as an icon. Double-click this icon
to see its window. You can now add programs, or even other
MewGroup  groups, to this new group within a group. Choose New Group from
the window’s File menu and follow the same process.
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Groups within a group are not listed as separate buttons in the
Dashboard Program menu. Rather, they are listed as items of the
group they are in.

NOTE: Groups within a group cannot be copied or moved.

Adding a New Program ltem to a Group

To add a new application to a program group:

1. Double-click the Program Menu button in the Dashboard for
the program group you would like to open. This program group’s

Program Window appears.

2. Choose New Item from the File menu.

3. Enter the program’s description, command line, working
directory, and Hotkey information.

Program Item Properties

Descripti I“' ft Excel |
Command Line: C:\EXCELMEXCEL.EXE

Working Directory:  |C:\EXCEL

Shortcut Key: |Ctrl +Al + X

Hicrestt
5

[ Run Minimized

i

Control Panel Print Manager

4. Click OK, and the new
program item’s icon will

appear in the group % p
window. The program M !
description is displayed

as the title under its Lol

icon.

DRIVING TIP: You can also
add a new item by dragging a program from the File Manager,
another program window, or from the Quick Launch buttons.
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Extended Screens

Using Dashboard with its extended screens is like connecting
your computer to several side-by-side monitors. Although you work
with only one monitor at a time, you could open programs on all
the monitors, and then switch back and forth among the monitors
to work with the different programs. On Dashboard, each
extended screen functions like a separate monitor.

For example, let’s say you want to work with Microsoft Excel, Ami
Pro by Lotus, and Core]DRAW. Rather than having all these
programs piled up on the same screen, open Excel on the first
extended screen, Ami Pro on the second, and Core] DRAW on the
third. Now, to work with the different programs, simply switch
back and forth among the screens by clicking the screen selectors
or by double-clicking the screens themselves.

Each extended screen shows the open programs on the full screen.
Think of them as separate monitors attached to your computer.

Program icons and
names indicate which
program is represented
by that miniwindow.

A minimized program
is shown with a
minimized icon.

Clicking a screen Each miniwindow
selector activates its represents an open
extended screen. program.

Looking at Dashboard's extended screens, you’ll notice the
labeled miniwindows that represent each open program. The size
and position of each miniwindow on the extended screen is exactly
proportional to the size and position of the actual program window
on your full screen. For example, if you're running File Manager,
and the File Manager window fills three quarters of the screen,
then the File Manager miniwindow will fill three quarters of the
extended screen. Similarly, a minimized program would be
represented by a minimized icon on the extended screen.
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What the extended
screen shows

What you see on screen

File Manager - [CAWINDOWSY*.*]
File Disk Tree VYiew Options Window Help

22 snappro coreldrw 2/14/92 |
2 tempfile Coatrol Panel

g 3::25:;1 Settings Help

£ coreldrw % - @

2 msapps Y

£ system Fonts Poits Mouse Desktop
¢ &

Printers  International Date/Time 386 Enhanced  Drivers

r

Micye ot

The extended screens are completely interactive with the full-screen
views. If you move or resize a program window on the full screen,
the miniwindow moves and resizes in a corresponding way. And if
you bring one program to the front of another, the miniwindows on
the extended screens will reflect the change. It also works the other
way. If you move miniwindows on the extended screens, the
programs they represent will move on the full screen.

DRIVING TIP: The extended screens resize with Dashboard.

To save space, the screen selectors may disappear. In this case,
simply double-click the screens themselves to switch back and forth.
If you need to make the screens even smaller, use the Customize
button to display them as compact instead of the default Full Size.
You can also change the number of screens or choose a different
background. See “Extended Screen Preferences” in Chapter 4.
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Using Extended Screens to Organize Programs

Each miniwindow interacts with the program window it
represents. If you move one, the other moves as well. Organize the
miniwindows on the extended screens exactly as you want the
program windows to appear.

Move a miniwindow into another extended screen and the program

window disappears from the active screen. The program is still
open,; it has just been moved to another full-screen view.

Screen selectors

To see the program window in its new full-screen view, use the
screen selectors to activate the extended screen that contains the
miniwindow. Or you can simply double-click the miniwindow, and
Dashboard will automatically switch to that full-screen view.

Then, to switch screens just enter the custom Hotkey for the screen
you want to go to, and Dashboard will switch you there. See
“Extended Screen Preferences” in Chapter 4.

DRIVING TIP: Open your favorite programs and use the
miniwindows to organize them on different extended screens.
Save that arrangement as a layout using the Layout menu. Later,
you can open all of those programs and return them to the same
position, all in one easy step. See “Working With Layouts” in
Chapter 4.
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Printing and Faxing

Default
printer light

The Printer Manager controls all of the printers, fax machines, and
plotters that you have installed and configured in Windows. With
the Printer Manager, printing or faxing a file is as easy as dragging
it from the Windows File Manager to Dashboard's printer icons.
You can also use Dashboard to change the default printer by
simply clicking the default printer light.

A green light (on a color monitor) denotes the default printer. This
is the default printer light. To change the default printer, just click
the button you want to make the default printer. The light will
turn green, indicating that this is now the default printer. You can
also change the default printer using the Customize button. See
“Customizing the Printer Manager” in Chapter 4.

The Printer Manager shows all the printers and other output
devices you installed with Windows. Click an icon to see a brief
description of it. Double-click to see the standard Windows Printer
Setup dialog box.

Printer Manager Scroll arrows
LPTS3 indicates the port this printer has been assigned to. You
assign a printer to a particular port when you install it on your
system using the Windows Control Panel.

If you have too many printer icons to be displayed at the same

time, use the scroll arrows next to the icons to see those that
aren’t visible.
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Click the Customize button to see the Customize dialog box. Then
select Printer Manager to change the order of the printers, hide a
printer, pick a different icon for each printer, and name each
printer with your own title.

Customize - DEFAULT.CFG

File Help
LChoose an Item to Customize. Printer Manager Preferences
or Drag an item to Move Default Printer
Dashboard bp DeskJet on LPT1: —]
Program Menu

Choose a Printer to Configure or Reorder.

HP DeskJet on LPT1:
HP LaserJet 2000 on LPT1:
HP Laserfet {il on LPTZ:

HP Laserdet Series Il on LPT1:

* Printer Manager

e

@ DRIVING TIP: To resize the Printer Manager panel in the
Dashboard window, hold down the Shift key and move the
cursor to the edge of the panel. When the cursor changes to a

sizing arrow, click and drag the gray border that appears. The
panel shows as many items as possible in the space you've defined.

The Printer Manager offers a quick and easy way to handle all
your installed printers. However, the Printer Manager does not
install these printers. To install a printer on your system, use the
Windows Control Panel. Refer to your Windows manual if you
have any questions.
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Printing from the Dashboard Window

When you're working in a program, you'll probably print by choosing
Print from that program’s File menu. But if you aren’t working in

a program and want to print a file, you can print it directly from
Dashboard without having to first open the program.

1. To print directly from Dashboard, first locate the data file you
wish to print. Select it from the File Manager, the Program menu,
a Program Window, or elsewhere.

2. Drag the file to the desired printer icon on the Dashboard
window, and drop it on the printer icon. This triggers printing.
Depending on which program the file was created in, the program
may launch and ask for confirmation to print.

__ ?iléhénééé}h
The cursor changes 1 File Disk Tree View Options Window Help

to this icon "banned” ‘ _ CAWINDOWSY .~
bar to prevent you & _ ]

from dragging the file
to an area which is
not a valid drop zone.

€ seingrbs 1 31092
£ shappro 310492
£ tatalcom 310492
€ windisk? B 3/10/92

A file icon fr(.)m Fi].e el e ﬁ;gﬁgg
Manager looks like this
when it is dragged over

a valid drop zone such
as the Printer Manager.

Fil: Manager

NOTE: Programs that support drag-and-drop printing are listed in
the Windows registration database. If a program is not listed in
this database, drag-and-drop printing will not work. Consult your
Windows 3.1 User’s Guide to add an unlisted program to the
Windows registration database.
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Working With Toolbars

Several of Dashboard’s panels can snap off to become floating
toolbars that can be resized and repositioned anywhere on screen.
These include the Program menu, the Quick Launch panel, and the
Printer Manager.

To set which panels are displayed as snap-off toolbars:

1. Click the Customize button to open the Customize dialog box.

2. Select the Toolbars tab under Dashboard Preferences.

3. Check which Dashboard panels you would like to be snap-off
toolbars, and click Done.

Toolbar preferences

Customize - DEFAULT.CFG

File Help

Choose an {tem to Customize DasHboard Preferences
or Drag an Item to Move

@ Program Menu

mﬂmck Launch Snap-off Toolbars

m Clock/Calendar

£4 Extended Screens Program Menu
Quick Launch

ingi Printer Manager Printer Manager

[ Toolbars minimize with Dashboard

Once you designate a panel as a toolbar, it will be reduced to one
button on Dashboard. Click this button to open the toolbar.
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Click here to see the
Program Menu toolbar.

Click here to see
the Toolbar menu.
Double-click to close
the toolbar.

Click here to see the Click here to see the
Quick Launch toolbar. Printer Manager toolbar.

The toolbars themselves (such as the Quick Launch toolbar shown
below) can be resized and repositioned anywhere on screen.

Click here to customize
the toolbar, or choose
Customize from the
Toolbar menu.

Use the toolbar
edges to resize.

Items on the toolbars behave exactly as they do on the Dashboard.
Thus, you drag items to rearrange them on the toolbar. To copy an
item, drag it while holding down the Ctrl key. To move the toolbar
using the keyboard, choose Move from the Toolbar menu. To launch
a program from the Program menu or Quick Launch toolbars, either
click the program icon, or drag the icon to an extended screen. To
print a file, drag it to the printer on the Printer Manager toolbar.

NOTE: The position of the toolbars remains consistent on every
extended screen.

DRIVING TIP: Toolbars work in conjunction with Dashboard.
Thus, the Hotkey sequence that you defined to activate Dashboard
will bring the toolbars to the front as well. You can also set the
toolbars to minimize with Dashboard. See “Dashboard
Preferences” in Chapter 4.
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Checking Your Resources

Windows uses the memory available in your computer to run
programs, but it also reserves a portion of memory for its own use
for system resources. The two key components of system resources,
called USER and GDI (short for Graphics Device Interface), both
reserve their own 64 K of memory. Each Windows program
running uses up a portion of system resources memory, and when
the available pool of GDI and USER memory runs low, you will not
be able to open new Windows programs.

In other words, even though your system may have sufficient free
memory for a program to load, not having enough memory left in
the two 64 K sections reserved by Windows means that you can’t
open any new programs.
Resource Gauge
With Dashboard's Resource Gauge, you can easily keep an eye on
the amount of system resources you have left. As in the gas gauge
in your car, the needle drops toward empty as system resources get
low. You can also open the Resource Gauge window to get a
summary of resource usage by the Windows GDI and USER
components.

Warning
indicator

Memory meter . . .
Y In addition to the memory set aside as system resources, Windows

manages the rest of the computer’s memory for active programs.
Each program running also uses up a portion of this available
memory. And much like your system resources, when you run out
of memory, you can’t open any new programs.

Dashboard can help here too. Dashboard's “odometer” is a
memory meter that displays the total amount of free system
memory left to use. The numbers given are exact kilobytes.

When you get low in either system resources or total free memory,

the Warning Indicator begins to blink and an alarm will sound.
You can set the level at which this happens.
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Click to exit the —]

Resources dialog box.

Resources Dialog Box

To set the Warning Alarm level, double-click on the Resource
Gauge or Memory meter; the Resources dialog box appears.

Resources

Select item to View:
Memoiy and Resouices
System Environment
Drive Usage
Applications Running
Environment Variables

Total
Free
Used
Z Free

Alarm

System

System Resources

Click here to print a
copy of the information
displayed in the
Resources dialog box.

Memoty &DI USER Enter warning
20380K 64K B4K values in these
14435K 44K 48K -

5945K 20K 16K boxes to deter
70 70 75% mine when the
64 K Free % Free Alarm goes off.
o Choose the
D!:play system memory odometer. sound made by
Display system resources gauge. ] the Warning
Gauge Type: [FuclGouge [ Alarm.

— Check here to — Use the pull-down
display the Resource menu to select a display
Gauge on the option for the Resource
Dashboard. Gauge.

The alarm will sound when available memory reaches the warning
values you set in the Warning Alarm boxes. Use kilobytes for total
memory and a percentage for system resources. For example, if you
enter 100 K for the alarm level for system memory, the alarm will
sound when only 100 K of free memory is left in your computer.
And if you enter 20 percent for system resources, the alarm will
sound when either the GDI or USER resources has only 20 percent
of memory left (whichever reaches the limit first). Normally, the
default settings will be adequate.

DRIVING TIP: You can also reset the Warning Alarm levels or
change the Resource Gauge from a gas gauge to a bar gauge using
the Customize dialog box. See “Customizing the Resource Gauge”

in Chapter 4.
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You can view more system information by choosing from the
following menu in the Resource dialog box.

Select Item to View:

Memory and Resouices
System Environment
Dnive Usage
Applications Bunning
Environment Yarnables

* Memory and Resources shows a chart of the exact kilobytes and
percentages of both the total memory and system resources
available.

* System Environment lists information about your computer.

* Drive Usage shows information about available disk space for
each one of the drives on your computer. See “Customizing the
Resource Gauge” in Chapter 4.

» Applications Running lists all of the currently open programs
and their memory size. You can close programs from this
dialog box by selecting the program and clicking the Close
Application button.

¢ Environment Variables lists the DOS environment variables
currently being used.
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Setting an Alarm

Use Dashboard's Alarm feature to help you keep track of your
busy schedule. Set an alarm to flash a message, chime a sound, or
even launch a program. To repeat the same alarm everyday, or on a
specific day of the week, use the Recurring setting. Use the
Calendar to set alarms weeks, or even months, in advance.

To set an alarm, double-

click the Alarm Clock or
Calendar.
Alarm Clock
Calendar

Click Add to create a
" Clock Alarms new alarm.

- ind
alarms you’ve 2:00 PM Reminder

This list shows the Alarms:
5:26 PM Reminder
already set.

2/3/93 3:00 PM Meeling with Joan

Click Edit to change
L——— the characteristics of
an alarm.

To remove an alarm,

highlight it and click
Delete.

Click Configuration to

set clock and calendar
preferences.

Click OK to set —]
the alarms listed
above and exit.

Click Cancel to exit without
saving any changes.

To change the characteristics of an alarm, click the Edit button; the
Alarm Settings dialog box will appear.
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Click OK to save ——| i)

To set the time for the Alarm to sound, select the hour and minutes
and enter new values. Choose whether time set is AM or PM. Select
Recurring for alarms that repeat every day or once a week. Choose
a setting from the pull-down menu.

= “Alarm Seftings
Time: 2: 00ff
Alam Text: [Reminder —H Enter the text here
Show Alarm: - that you want to
C Recuriing: appear with the
alarm message.
Optional Alarm Actions:
Run Program: [ ]

Warking Directory: |

[ Run Minimized

Click Browse to select
the command line.

sounc: [T B

Click Cancel to exit
without saving
any changes.

Enter a specific date for the Alarm. Dates with alarms will be
highlighted on the Calendar.

To set the Alarm to launch a program, enter the program’s path
and working directory in the Run Program box. Check the Run
Minimized box to have the program opened as minimized. When
the Alarm goes off, Dashboard will automatically open that
program in addition to displaying the Alarm Message text you
entered.

Choose the Alarm’s sound from the pull-down menu. To hear a
sound, select it in the list and click Play Sound.
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Your personalized
alarm message is
displayed here.

Standard Alarm Message

When an alarm goes off, the following message box appears on your
screen. You can either click OK to close the alarm message box, or
click Snooze to close the alarm message temporarily. The alarm
message will appear again after a specified Snooze Interval.

5:31 PM Reminder

NOTE: If you don't close the alarm message within an hour, it will
close automatically.

DRIVING TIP: Use the Windows Control Panel to adjust the volume
and duration of the alarm sound. See Chapter 1 for more informa-
tion about installing the PC Speaker sound driver. The alarm will
appear only when your computer is on.
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Customizing DASHBOARD

Use the Customize button to take advantage of all the features
offered by Dashboard. Rearrange or hide items, create Quick
Launch buttons for your favorite programs, choose different faces
for the Alarm Clock, and much more.

Click the Customize button to open the Customize dialog box.
Select an item from the item list, and its preferences will be
displayed to the right.

Preferences
section

ol Customize - DEFAULT.CFG
File Help

Choozse an Item to Customize Dashboard Preferences |
or Drag an ltem lo Move %

D ashboard L . ——

Item list — Quu:k Launch [[] Dashboard always in front
CIocleaIendav [Xl Use Dashhoard as Windows Shell
:x:::;z:sscleens Replace Windows Tatk Manager
%Plintel Manager Show ic_ons in menus and screens
Title Bar Display
I[standald] Ji
Minimized Display
[[slandald]
Window Drientation
|V© I O Vertical |

Click Undo to nullify  Click Done to close the Customize
all changes. dialog box and save all changes.

Click Hide Item to display Dashboard without the currently
selected item in the item list. Dashboard itself is the only item
that cannot be hidden.
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Preferences

This section of the dialog box displays the preferences for the
currently selected item. To customize a particular item, choose it
from the item list, and its options will appear. Choose the new
options you want and you’ll see the changes on Dashboard. To
keep the changes, click Done and the dialog box will close. Your
changes will be put into effect. Click Undo if you don’t like them;
Dashboard's window will appear as before.

item List

Choose an Itom to Customize
— Al] the items on the item list below the separator line can be
rearranged. The sequence of these items—top to bottom—

corresponds to their sequence in the Dashboard window—left to

B¥ Extended Scroons

B Forources right. If Dashboard is being displayed vertically, then the

Bl Printor Manager sequence of the items in the list will correspond directly, from top
to bottom, to their sequence in the Dashboard window. To change
an item’s position, simply drag it to a new place in the list. As you
drag the item, it will be placed in that same relative location on the
Dashboard window.

DRIVING TIP: Double-clicking a Dashboard item with the right-
hand mouse button displays Customize options for that item. For

example, to configure more Quick Launch buttons, double-click any
Quick Launch button with the right-hand mouse button. The
Customize dialog box will appear, and the Quick Launch
Preferences will already be selected. (This feature only works if you
do NOT designate Right double-click as the mouse shortcut for
activating Dashboard. See “Dashboard Hotkeys Preferences”
later in this chapter.)
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Rearranging ltems in the DASHBOARD
Window

You can rearrange the Dashboard window to suit your personal
working style. For instance, you might like to have the clock on the
far right and the extended screens on the far left. To rearrange

an item, drag it to a new position on the list in the Customize
dialog box.

Click the Customize button to see the Customize dialog box.

Choose an Item to Customize
or Drag an Item to Move
D ashboard

If Dashboard is being
displayed vertically,
then the sequence of the
items in the list will
directly correspond to
their order in the
window.

Ttems listed above this
line cannot be moved.

@ Program Menu
Quick Launch

£ Clock /Calendar
El Extended Screens
m Resources

@ Printer Manager

These are the items you
can rearrange in the
Dashboard window.

The sequence in the list—top to bottom—corresponds to the
sequence in the Dashboard window—left to right—for a
horizontally displayed Dashboard.

A typical Dashboard
configuration
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To change the place of an item, simply drag it to a new position in
the list. For example, if you want the Quick Launch panel on the
far right, drag it to the bottom of the list.

Choose an Item to Customize
os Drag an Item to Move

Printer Manager

Chaose an Item to Customize, Here is an example of a different Dashboard

oi Drag an Item to Move arrangement along with its corresponding list.

e,.u (not shown) Note that this one does not show the Program
(G Printer Manager Menu. It has been hidden to save space.

E Quick Launch

g Extended Screens

DRIVING TIP: To change the position of an item on the Dashboard
using the keyboard, use the cursor key to select the item from the

list then press Ctrl-Alt. Then use the arrow keys to reposition the
item.

DRIVING TIP: To resize individual Dashboard panels such as the
Printer Manager, Quick Launch buttons, and Program menu (for
vertical Dashboard), hold down the Shift key and move the cursor
to the edge of the panel. When the cursor changes to a sizing arrow,
click and drag the gray border that appears. The panel shows as
many items as possible in the space you've defined.
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Custom DASHBOARD Configurations

The arrangement of the items in the Dashboard window is known
as the configuration. Using the Customize dialog box, you can
change the configuration to suit particular tasks and then save
each configuration as a file for future use. Later, when you return
to work on that task, you can load the corresponding configuration.

Two different
configurations
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Saving Custom Configurations

To save a configuration:
1. Click the Customize button. The Customize dialog bar appears.

The title bar shows the name of
the current configuration file.

Customize - DEFAULT.CFG

File Help

Choose an Item to Customize Dashboard Preferences
o1 Diag an Item to Move
Dashboaid
E Program Menu
Quick Launch
B Clock/Calendar
Extended Screens
-Hesoulces
Printer Manager

O Dashboard always in front
Use Dashboard as Windows Shell
Replace Windows Task Manager
Show icons in menus and scieens
Title Bar Display
|[:landald]
Minimized Display
|[xtandald]

Window Drientation
| Horaaria

O Vertical ‘

2. Make all the design changes to each item and its preferences in
the dialog box.
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3. Choose Save from the File menu to save the current

ALL configuration under the same name.
Ve AS...

Load...
02 Or
Close

Choose Save As to save the current configuration under a
different name. The Save Configuration File dialog box

appears.

Save Cenfiguration File

File Name: Directories:

Fiveszcin.cfg l c:\dash

& ch
dash

dedfank, oy

Save File as Type: Drives:

Conlig. Files [*.cfg) @ c: %

4. Enter a new file name for the configuration you are saving.
A .cfg extension is automatically added to the new file name.

5. Click OK to save the new configuration. Notice that the title
bar of the Customize dialog box will change to show the name
of the new configuration.
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Reusing Custom Configurations

To use a Dashboard configuration that you have previously
created and saved:

1. Click the Customize button.

2. Choose Load from the File menu in the Customize dialog box.

3. Choose the path and name of the file to load.

Save
Save As...

Load lfnni@ur';\innﬁlfﬂi 77

File Name: Directaries:

= e
£ dash

List Files of Type: Drives:

Config. Files (*.cfg) i [ ﬁ

4. Click OK, and then click Done on the Customize dialog box.

Dashboard takes on a custom configuration.

You can work with only one Dashboard configuration at a

time. Use the Load command to load a different configuration file.
When you close the Dashboard window, its configuration will
automatically be saved in the current configuration file.
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Remember, a configuration is the arrangement of items on the
Dashboard, whereas a layout is the arrangement of program
windows on the extended screens. Sometimes, the two are related.
For example, a layout spread out over five extended screens looks
best with a configuration showing five screens. (If the current
configuration showed only three screens, Dashboard would
combine the extra screens to fit into three.) If you create a complex
layout that requires a special configuration, save the configuration
as a separate file. Then, when you want to work with the layout,
first open the configuration, then open the layout. For more
information on layouts, see “Working With Layouts” later in

this chapter.
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DASHBOARD Preferences

To make changes in the Dashboard preferences:

1. Click the Customize button to open the Customize dialog box.

Choose an Item to Customize
or Drag an Item to Move

D ashboard

g Program Menu

m Quick Launch

8 Clock/Calendar
ﬁ Extended Screens
@ Resources

@ Printer Manager

The Dashboard is already selected as the item to customize.
The preferences section shows Dashboard Preferences.

2. Select one of the tabs (Main, Hotkeys, Fonts, Colors, or
Toolbars) to choose which aspect of the Dashboard to
customize.

Dashboard Preferences

[l Dashboard always in front

X Use Dazhboard as Windows Shell
[ Replace Windows Task Manager
Show icons in menus and scieens
Title Bar Display

uslandald]

Minimized Display

L[slandald]

Window Orientation
[@ Horizontal O Vertical
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Check this box if you
want to run Dashboard
as the shell program.

Check this box to use
Dashboard’s own
Task Manager instead
of the Windows Task
Manager.

Use this pull-down
menu to have the title
bar display the time
and date or your
system resources.

Standard Dashboard
minimized display

Dashboard Main Preferences

Select the Main tab to change the Dashboard's main preferences.

O Dashboard always in front

1 Usge Dashboard as Windows Shell

— Replace Windows Taszk Manager

& Show icons in menus and screens
Title Bar Display

—-I [standard)

Minimized Display

—I [standard)

Window Orientation
IV@ Horizontal O Vertical

Use this pull-down menu to change the icon
displayed when the Dashboard is minimized.

Title bar with the time and date

Use this box to designate
whether Dashboard
will always appear in
front of the other
programs on screen or
come to the front only
when activated.

Check this box to
display miniprogram
icons in the extended
screen and Program
Group menus.

Choose between
displaying Dashboard
horizontally or vertically.

Clock minimized
display display
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DRIVING TIP: If you're short on screen space, you can select
extended screens as your minimized display. Then with
Dashboard minimized, you can switch back and forth
between applications by clicking the boxes in the icon.

Dashboard Hotkey Preferences

Select the Hotkey tab to change the Dashboard's Hotkey
preferences.

In the Shortcut Key box, enter your own keyboard combination to
toggle between bringing Dashboard to the front and sending it
behind the other programs on screen.

Shortcuts to activate Dashboard

Type a key in box below. CTRL + ALT will be
added as required.

Shortcut Key: F12

Click any mouse button or combination in the box
below. except for Left Button alone.

Mouse Shortcut: |Left+Hight Buttons j

To enter a mouse shortcut, place the cursor in the box. The default
setting “Left + Right buttons” will be highlighted. On the mouse,
click the combination you would like to set. The text in the box will
change to show what you clicked.

When choosing a mouse shortcut, choose any combination of mouse
clicks (except left button alone), or a combination of any modifying
keys and the above (such as Alt + Right button). However, you
may wish to avoid using right button double-click, since this is
already a predefined feature. See “Customizing Dashboard” at
the beginning of this chapter.
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This list contains the
names of all the fonts
currently installed on

your system.

DRIVING TIP: Hotkeys can be created using a combination of
different types of keys including function keys F1-F9 and F11-F24
(if you have them), modifying keys such as Alt, Shift, and Ctrl,
ASCII keys, and arrow keys. Backspace, Delete, and the spacebar

will erase the key entry. Choose a sequence that is unique and
easy to remember.

Dashboard Font Preferences

Select the Font tab to change the font to appear in all of the
Dashboard panels.

Font Font Size
r Fixedsys

M5 Sans Serif
M5 Serif
MT Extra
Preview
Small Fonts

Font Style

Depending on the fonts you have installed on your system, you may
have several different choices for font styles.

[

— Click here to return
font to its default
settings.

You can also customize the size of the font used in the Dashboard
panels. The font sizes are listed in points, and are limited to a
range of 6 to 12. The Dashboard will automatically change its
size to accommodate the new font size.
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Dashboard Color Preferences

Select the Color tab to choose a color for Dashboard's window.
Notice that this will only affect Dashboard's window, and not the
entire Windows background, or the extended screens background.
To change the extended screens background color, change the
extended screens preferences. See “Extended Screens Preferences”
later in this chapter.

Colors |

I~ Colof Schemes

Click here to return
Click here to set the ) Gray-Scale Colors colors to their default

Dashboard back- settings.
ground color scheme
for use on gray scale
monitors.
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Dashboard Toolbar Preferences

Select the Toolbar tab to choose which Dashboard panels will be
snap-off toolbars. Panels designated as toolbars are reduced to a
single button on the Dashboard. Click the button to see the
toolbar. See “Working With Toolbars” in Chapter 3.

Snap-off Toolbars

[ Program Menu
B Quick Launch
[ Printer Manager

Check this box to —-L Toolbars minimize with Dashboard
automatically minimize

the toolbars when you
minimize Dashboard.
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Changing the Program Menu

To make changes in the appearance and attributes of the
Program menu:

1. Click the Customize button to open the Customize dialog box.

2. Select Program Menu as the item to customize. The
preferences section now shows Program Menu Preferences.

Listed in the program menu preferences are all the program
groups that appear in the Program menu. To change the order of
the buttons on the Program menu, change the order of the program
groups listed here. Select a group and drag it to a new position in

the list.
Program Menu Preferences
Program Groups ) Click Modify to change a
[Drag an item to reorder list} B .
group’s properties.
If you are running
Dashboard and Click here to open
Program Manager at the selected program
the same time, click Word Processing : group’s window.
here to synchronize Dashboard
the two. L Click Delete to remove
- the selected program
Check this box to show ~—+——{7 Show 2nd Row of Text group.
the full-size Program T Show Color Keys
menu buttons. Click New to create a
| new program group.

Click this box to show Click here to hide the

the color corner tabs on selected program group.

the Program menu Hidden groups will not show
buttons. up in the Program menu.
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If you are running both Dashboard and Program Manager at the
same time, you will be able to modify the program groups in either
program. Any changes you make using Dashboard will
automatically be reflected in Program Manager.

However, if you use Program Manager to change the program
groups, the changes will not be reflected in Dashboard until you
click the Reread from Program Manager button, or until you close
and reopen Dashboard. Of course, if you run Dashboard as the
shell instead of Program Manager, you will be making changes
with Dashboard only, and will thus avoid these extra steps. See
“Dashboard Main Preferences” earlier in this chapter.

Click Modify in the program menu preferences to open the Modify
Program Group dialog box.

To give a program

group a new name, _
enter it here. - Group D [Main l
‘_J L Group File: [C:A\WINDOWS\MAIN.GRP |
To change the group file Color Key: | I
associated with this

group, enter the full
path here.

Jmﬁl;m'gr;1 Group

DRIVING TiP: If you want to conserve space in the Dashboard
window, make your favorite programs Quick Launch buttons or

Click one of these colors to change the corner
tab on the Dashboard button for this group.

save them in a layout, then hide the Program menu.
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Quick Launch Preferences

Launching your favorite programs has never been easier. You can
now launch any program directly from Dashboard with a click of
the mouse or a few keystrokes.

Set up a Quick Launch button for each of your favorite programs
using the Customize dialog box. Each program’s Quick Launch
button will be displayed right in the Dashboard window. To open
a program, simply click its button.

Creating Quick Launch Buttons

You can instantly create a Quick Launch button by dragging a
program file (for example, cardfile.exe) from the Windows File
Manager, an open progtam window, or the Program menu to the
Quick Launch panel. It’s as easy as that.

You can also create Quick Launch buttons using the Customize
dialog box.

1. Click the Customize button to open the Customize dialog box.

Choose an ltem to Customize
of Drag an ltem to Move
Dashboard
@ Program Menu

| Clock /Calendar

i Extended Screens
@ Resources

ﬁ Printer Manager

2. Select Quick Launch as the item to customize. The preferences
section now shows Quick Launch preferences.

You can also double-click a Quick Launch button with the right-
hand mouse button to see the Customize dialog box for the buttons.
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To create a new Quick Launch button, click New. Enter a
descriptive title for the program in the Title box. It does not have to
be the program’s real title, it can be anything. Enter the path and
file names for the program in the Command Line box.

This is the list of Quick —
Launch buttons you’ve
already defined.

Enter a working
directory if you wish. —
See Driving Tips.

Huick Launch Preferences

MS Wriite
Control
Title: File Manager
Command Line: C:\Windows\Winfile_exe
+ Working Directory: lE:\Windows j
Shontcut Key: l&me I

[] Run Minimized——————

Button Style
[@ Unlabeled (O Labeled O Mini J

To delete a Quick
Launch button, select it
in the list and click the
Delete button.

Check this box to open
the program as
minimized when you
click the Quick Launch
button.

Enter a Hotkey sequence for this program in the Shortcut Key box.
Then, whenever you type the Hotkey, the program will be
automatically launched and placed in the front of the currently
active screen. If the program is open but minimized, the Hotkey
will activate it.

If the program contains an icon file, its icon appears on the Quick
Launch button by default. Click Change Icon to change the default
icon. Click Browse to select the program’s path and file names as
the command line.

Change the Button Style to display the Quick Launch buttons as
unlabeled, labeled, or minibuttons.

Unlabeled buttons
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DRIVING TIP: Using Quick Launch preferences, you can assign a
program a new default location known as the Working Directory
for saving and opening its files. For example, you might want to
save all your Paintbrush drawings in a directory named
GRAPHICS. Simply enter the GRAPHICS path in the Working
Directory box of Quick Launch Preferences for Paintbrush. Then,
unless you specify another directory when saving a Paintbrush file,
all your drawings will be saved in GRAPHICS.

DRIVING TIP: When working in DOS, you cannot use the Hotkey
to launch a program. However, if the program is already running,
the Hotkey will activate it.

DRIVING TIP: Create Hotkeys using a combination of different
types of keys including function keys F1-F9 and F11-F24 (if you
have them), modifying keys (such as Alt, Shift, and Ctrl), ASCII
keys, and arrow keys. Choose a sequence that is unique and easy
to remember.
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Alarm Clock and Calendar Preferences

To change the appearance and attributes of the Alarm Clock and

Calendar:

1. Click the Customize button to open the Customize dialog box.

2. Select Clock/Calendar as the item to customize. The prefer-
ences section now shows Clock and Calendar preferences. As a
shortcut, double-click on the Clock or Calendar with the right-
hand mouse button to see the Clock and Calendar preferences.

|2l Show Calendar

Check this box to
display the Calendar. (X Show Clock
[ Clock Pref:
Clock Type

® Analog
O Digital

Clock Face:

Check this box to see

Y| Second Hand

 Calendar Pref

Highlight Colors — )

Today:
- e
Alaims:
Il E N

[ Ho Highlights

a second hand on
the Analog Clock.

Snooze Interval: El m minutes |:

Choose a highlight color
for both the current date
and all those dates with
set alarms. Or, choose
No Highlights if you
prefer.

Click to display the
current day in the
Calendar.

Click here to set
an alarm.

For Clock Type, choose between an analog a and digital display.

Analog
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Clock Face

If you've chosen analog as your clock type, click the menu to see a
list of different analog clock styles. Choose the new style for the
clock; it will be displayed in the Dashboard window.

Ruby Square Round

DRIVING TIP: If you are using a communication program that has
a “time-out” feature, turn the Second Hand option OFF to avoid a
time-out every time the clock repaints the second hand.

Snooze Interval

When an alarm goes off, you have the option of clicking Snooze.
This will temporarily shut off the alarm. However, the alarm will
sound again after a set number of minutes known as the Snooze
Interval. To set the Snooze Interval, type the number of minutes
you want to wait until the alarm sounds again in the Snooze
Interval box.

DRIVING TIP: The Alarm Clock and Calendar show the date and
time as set on your computer. To reset the date and time, use the
Windows Control Panel.

You can also get to the Clock Preferences dialog box by double-
clicking the Alarm Clock or Calendar, and then clicking the
Configuration button in the dialog box that appears.

The alarm will only sound when your computer is on.
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Extended Screens Preferences

To make changes in the appearance and attributes of the
extended screens:

1. Click the Customize button to open the Customize dialog box.

2. Select Extended Screens as the item to customize. The pref-
erences section now shows the extended screen preferences. As
a shortcut, double-click on any extended screen with the right-
hand mouse button to see the extended screens preferences.

Extended Screens Main Preferences

Select the Main tab to choose the number of extended screens to be
displayed in the Dashboard window. Depending on the size of the
window and your monitor’s resolution, you can display up to nine
screens at once. If you need more space for extra screens, hide
some of the other Dashboard items.

Extended Screens Preferences

Main
 Mumber of Screens ™ ] [ Display ™ |
@ Full Size — Click to choose a size
Click here to use a ®3 0507 O3 O Compact for the extended
predefined background for screens. Click Compact
the extended screens. ~Background to make the screens
Choose one from the pull- . smaller on Dashboard.
down menu. @ Predefined:
|Blue
Click here to use the (") Use Windows background
. currently selected O Bitmap:
Windows wallpaper as
the background for the |
extended screens.

Click here, then enter Click here to use your
the path and file names own custom bitmap file
in the Bitmap entry for the background for
box. extended screens
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DRIVING TIP: Open your favorite programs and use the
miniwindows to organize them on different extended screens.
Save that arrangement as a layout using the Layout menu. Later,
you can open all of these programs and return them to the same
positions, all in one easy step. See “Working With Layouts” later
in this chapter.

If you have five or more extended screens open and then change to
a smaller number, any programs that are on the outer screens will
be moved into the remaining screens. You can then rearrange them
on those screens.

DRIVING TIP: If you need more space for extended screens, hide
other Dashboard items and use the title bar to show their
information. For example, hide the Clock and Calendar or the
Resource Gauge, then select Clock/Calendar or Resources as
the Title Bar Display. To change the Title Bar Display, use
Dashboard Main Preferences. See “Dashboard Main
Preferences” earlier in this chapter.
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Extended Screens Hotkeys

Select the Hotkeys tab to define Hotkeys for extended screens.
Enter a Hotkey sequence for each of your extended screens and
click Done. Then, to switch to a different extended screen, you don’t
need to hunt down Dashboard. Simply enter the Hotkey sequence
for the screen you wish to go to, and Dashboard will automatically
switch you there.

Extended Screens Preferences

ype here to define Scr

[F1
[F2
[F3
I MNone
Eone
l None

[None

lﬂone
E one

DRIVING TIP: Create Hotkeys using a combination of different

types of keys including function keys F1-F9 and F11-F24 (if you
have them), modifying keys (such as Alt, Shift, and Ctrl), ASCII
keys, and arrow keys. Choose a sequence that is unique and easy
to remember.

o 10 I~ I o e R N = g
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Extended Screens Sticky Apps

Select the Sticky Apps tab to designate applications whose icon you
always want on screen.

The list box shows all programs currently designated Sticky Apps. A
Sticky App always appears on screen, regardless of the extended
screen you are working in. No matter how you launch the program
(with Quick Launch buttons, from the Program menu, or with the
Run command), if it is on this list it will remain a Sticky App until
you remove it.

Extended Screens Preferences

l Sticky Apps

Click Add to select an application which will

always remain on the curent screen. Click here to open
Amaze Daily Planner the Add Sticky App

Microzoft Excel

F— dialog box.
Quicken 2 for Windows

._l Click here to remove
the currently selected

program from the list of
Sticky Apps.
The list box shows all programs ~ Add StickyApp |
Currently mning‘ SeleCt a program Select a sticky app to add:
to add to the list of Sticky Apps. Click Ty ——
OK to add, or Cancel to return to the e Managet
Sticky Apps dialog box. Wite
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Customizing the Resource Gauge

Enter exact
kilobytes for the
system memory
warning level.

Check here to display
the system memory
odometer below the

Resource Gauge.

To make changes in the appearance and attributes of the
Resource Gauge:

1. Click the Customize button to open the Customize dialog box.

2. Select Resources as the item to customize. The preferences
section now shows the chart of available system memory and
Windows system resources left in your system. As a shortcut,
double-click on the Resource Gauge with the right-hand mouse

button to see the Resources Preferences.

Main Resource Preferences

Select the Main tab Preferences to customize the Resource Gauge,
and to set the resources alarm. When you get low in either System
Resources or free memory, the warning indicator blinks and an
alarm sounds. Use the alarm field in main preferences to set the
level at which this happens.

Resources Preferences

System System Resources
Memory GDI USER
Total 20380K 64K 64K
Free 14420K 46K 46K
Used 5960K 18K 18K
% Free 0% 72z 3% Enter a percentage for
the system resources
Alarm 64 K Free % Free warning level.

—1-{4 Display system memory odometer. Choose a sound for the

Display system resouices gauge. warning alarm.

Gauge Type: IFueI Gauge
T

Check here to display Use the pull-down menu
the Resource Gauge on to select a display option
Dashboard. for the Resource Gauge.
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Resource bar gauge
without system
memory meter.

Resource “gas gauge”
with system memory
meter.

Drive Watch

Select the Drive Watch tab to make changes in the Dashboard
Drive Watch window. This window shows the available disk space
on each drive.

Listed here are all the drives your computer has access to, such as
floppy drives, hard drives, and network drives. The icons in the list
indicate the drive type. The chart shows the free disk space on each
of the drives,

Resources Preferences
Drive Watch
Used

10944 4E

Drive: C: [<Not specified>]

Drive Watch Specify how often
[ Update Interval: (15 [sec. Drive Watch checks
Check this box to the available space on
display the Drive —+X Display drive watch window. each drive.
Watch window on
Dashboard.

Click Add to add the selected drive to the Drive Watch window.
The Add button changes to Remove for drives that have already
been added. Click to remove the drive from the Drive Watch
window.
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Click Refresh to update the list of available drives. For example,
if you inserted a disk into your floppy drive after opening Drive
Watch, click Refresh to have it appear in the above list.

NOTE: The Update Interval (how often Drive Watch checks your
drives) may affect performance, especially with large network
drives. Experiment with various settings to determine the optimum
interval for your system.

DRIVING TIP: The Preferences dialog box is primarily for custom-
izing the resource display on Dashboard. For more detailed

information concerning your resources, double-click the Resource
Gauge itself. See “Checking Your Resources” in Chapter 3.
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Customizing the Printer Manager

This box shows which
printer, fax, or plotter is
the current default.

These are the currently
installed printers

Enter a description for
the selected device. This
description replaces the
name of the device on
Dashboard, and appears
when you click the
device.

Default Printer
—‘&P Desklet on LPT1:

To change the appearance and attributes of the Printer Manager:

1. Click the Customize button to open the Customize dialog box.

2. Select Printer Manager as the item to customize. The
preferences section now shows the printer manager
preferences. As a shortcut, double-click on the Printer
Manager with the right-hand mouse button to see the
Printer Manager preferences.

Listed in the Printer Manager Preferences dialog box are all the
currently installed printers, fax machines, plotters, and other
output devices. To change the position of the printer icons on
Dashboard, select the item from the list and drag it to a new
location. To install a new device, use the Printers section of the
Windows Control Panel. See your Windows manual if you have
any questions.

Check the Show Paper Orientation box to display the paper
orientation (either portrait or landscape) as part of the Printer icon
on Dashboard. Use Setup to change the orientation.

Printer Manager Preferences
] Show paper orientation

Choose a Printer to Configure or Reorder.

D
HP Lazerdet 2000 on LPT2:
HP Laserlet Ill on LPT3:

Click Hide Printer to
hide the selected output
device in the Dashboard

Description:

_JFL J window.

Click here to choose a
new icon for the Printer
button.
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You can change the default printer by selecting it in the list, and
clicking Set As Default. Alternatively, you can change the default
printer by simply clicking the default printer light.

Click Setup to see the Printer Configuration box for the currently
selected printer. You can also double-click the printer icon to see
this dialog box.

Click Hide Printer to remove the selected device from the
Dashboard window. The item will retain its place in the list of
installed devices, but it won’t be visible. If you select an item that
has been hidden, the button name changes to Show Printer. Click
to return the item to the Dashboard window.

Change Icon Dialog Box

Change lcon

Curtent Icon:

Scroll icons here

Scroll through the different icons and choose the one you want for
the selected printer. Click OK. That icon will appear in the
Dashboard window.
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Working With Layouts

Save Layoul...

Load Sample Layout
Custom Layout 1
Custom Layout 2
Custom Layout 3

e

Check this box if you — [-2X Load layout on startup

would like this layout to
be automatically loaded
whenever you open
Dashboard.

To save the current —]

layout, click OK.

Layouts are extremely helpful because they save you lots of time in
opening programs. A layout is an arrangement of open programs
on the extended screens. When working with several programs at
once, you'll find it convenient to open different programs on
separate extended screens. This makes switching between
programs much easier. Save the arrangement of these programs as
a layout. Later, instantly open all the programs and place them in
the same position on the extended screens by simply loading

the layout.

Design custom layouts for all your projects. When you are ready to
work, you won’t need to open each program individually. Simply
load the layout that corresponds to the project you are working on.

Creating Layouts

To create a layout, arrange the programs on the extended screens
just as you want them to appear when the layout opens. Then
choose Save Layout from the Layout menu. Enter a name for the
layout. This is not a file name. It can be any name you want.

Save Layout

nter a name for this Layout:

@slnm 1 ]

Programs for this Layoul: To remove a program

‘l-;i'lglManagel from a layout, select it

e from the list and click

Delete.
To exit the Save Layout
dialog box without
saving changes, click
Cancel.

In the list box are all the currently open programs on Dashboard.
All of these programs will be included in the layout when it
is saved.
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Editing Layouts

The command line for each program in a layout is recorded when
you click Save. To edit the working directory or parameters for a
program in a layout, select it from the list and click Edit. Youll see
the Edit Layout dialog box.

To open a specific file with a layout, include that file’s command
line as a parameter for the program it’s associated with. To do this,
enter the command line in the Parameters field of the Edit Layout
dialog box. For example, to open a document entitled Report.doc in
the program Write type:

c:\windows\write.exe report.doc

Also if you can launch the document report.doc directly from File
Manager and then save it as a layout, the parameter information
will be automatically saved.

Edit Layout

Enter a working
directory here. Application Name: |Write
Command Line: B\WNDDWS\WHITE.EXE

Enter a descriptive
name for the program

UL

- here.
| Working Directory: |C:\WINDOWS
If you want a —§— Parametess: |
particular file to Window Size: Choose a size for the

open as part of a
layout, enter the
path here.

window when the
program is first started.

! To exit without saving

To exit and save any changes, click Cancel.
changes made, click OK.

DRIVING TIP: Use the Save Layout and Manage Layout dialog
boxes to designate your favorite layouts as startup layouts. You can

have as many startup layouts as you wish. When Dashboard first
opens, it will automatically load all startup layouts.
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Choose a Layout
to load.

Loading Layouts

To load a layout, choose Layout menu from the System menu.

Manage Layouts...
Save Layout...

Load Sample Layout
Custom Layout 1
Custom Layout 2
Custom Layout 3

NOTE: Loading a layout launches all the programs associated with
that layout and puts them in their same position on the extended
screens. However, if a program is already open when you load a
layout that uses that program in a different position, it will not be
repositioned.

If you experience any problems loading a particular program in a
layout, see the readme.adyv file in the Dashboard program group.

DRIVING TIP: To have a program in a layout open a particular file
when the layout is loaded, use the Manage Layouts dialog box.
Select the program and click Edit. Enter the file name and
extension (like report.wri) as the parameter for the program,

and enter the directory that contains the file as the Working
Directory. Save the changes. The file will now open whenever
that layout is loaded.

DRIVING TIP: If you wish to disable the automatic launching of a

startup layout, you can hold down the shift key while Dashboard
starts up.

DASHBOARD OWNER’S HANDBOOK 81



Save Layout...

Load Sample Layout
Custom Layout 1
Custom Layout 2
Custom Layout 3

All the currently saved
Dashboard layouts
are listed here.

Check this box if you
would like the selected
layout to be automati-
cally loaded whenever
you open Dashboard.

Listed here are the
programs in the
selected layout.

To exit and save
changes, click here.
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Managing Layouts

The Manage Layouts dialog box is a handy place from which to
rename a layout, remove an application from a layout, or delete a
layout altogether. You can also designate a startup layout here and
open the Edit Layout dialog box.

To manage a layout, select Manage Layouts from the Layout menu.

To permanently remove a layout, select
it from the list and click Delete Layout.

Manage Layouts

Layout:

Custom2

Write

4 Load selected layout on startup

Applications for ‘Custom1’

To exit without saving
changes, click here.

Click Rename to change
the name of the currently
selected layout.

To remove a program
from the selected layout,
select the program and
click Delete.

To edit a program’s
working directory and
parameter information,
select it in the list and
click Edit.

CAUTION: The Delete Layout command will delete the entire
layout. Don’t confuse it with the Delete button. The Delete button

is for removing a program from the layout.



Index

A

About button, 6
Activating

Dashboard, 2, 12, 18, 58

See also Launching programs
Alarm Clock, 6, 43

customizing, 68-69

for launching programs, 23, 44

for low memory condition, 40

for reminders, 43-45

setting Snooze Interval, 45, 69
Alarm Settings dialog box, 44
Alt-T key combination, for viewing Task menu, 24
Alt key combinations, 18, 60, 72
Applications, Sticky Apps, 9, 73
Applications Running information, 42
Application Task Information dialog box, 26
Arrow key combinations, as Hotkeys, 60, 72
Arrow keys, 18
Automating startup, with startup layouts, 9-10

Background

choosing for extended screens, 70

of Dashboard, 61
Bitmaps, as background for extended screens, 71
Browse button, 25

Cc

Calendar, 6, 43, 68, 69
Cascading windows, 26
cfg extensions, 54
Clicking, on the mouse, 12
Clock
choosing clock style, 68, 69
See also Alarm Clock
Closing
Dashboard window, 13
dialog boxes, 18
programs with Task Manager, 26
Colors
for background of Dashboard, 61

for Clock and Calendar, 68

for program group corner tabs, 64
Command history, 25
command line

launching programs from, 24-25, 67

opening files from layouts, 80
Configurations

of panel items, 52

reusing, 55-56

saving, 53-54

versus layouts, 56
Contents of Help system, 16
Copying

program groups, 29-30

Quick Launch buttons, 20
Ctrl-Alt-Arrow key combinations, 18

Ctrl-Alt key combination, for repositioning items
from keyboard, 51

Ctrl-F6, 18

Ctrl-Esc key combination, for viewing Task
Manager, 10, 26

Ctrl key combinations, as Hotkeys, 60, 72
Cursor

as “banned” bar, 37

as question mark and arrow, 17
Customize button and dialog box, 6, 48-49
Customizing

alarms and messages, 43-45, 68-69

Calendar, 68, 69

colors, 61

Dashboard’s Main preferences, 48, 49, 58-59

display of printers, 36

extended screens, 70-73

fonts, 60

Hotkeys, 9, 59-60

mouse click sequences, 9

Printer Manager, 77-78

program groups, 27, 28, 29

Program menu, 63-64

Quick Launch buttons, 19, 65-67

Resource Gauge, 74-76

snap-off toolbars, 38-39, 62

toolbars, 62

for vertical display, 15

See also Rearranging
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D E

Dashboard for Windows Editing, layouts, 80
activating, 2, 12, 18, 58 Edit Layout dialog box, 80
described, v End key, 18
exiting or closing, 13 Enter key, 18
installing, 2 Environmental Variables information, 42
specifying as default Windows shell, 10, 58 Esc, 18
synchronizing program groups with Program Exiting
Manager, 29, 63, 64 Dashboard, 13
version 2.0 features, vii-viii menus or dialog boxes, 18
See also Customizing Extended Screen Preferences command, 9
Dashboard Run dialog box, 24-25 Extended screens, 6, 32
Data files, loading, 20 customizing, 70-73
Date, displaying on title bar, 58 designating Hotkeys for, 9, 72
Default printer light, 6 launching programs in, 21, 22
Defaults with Sticky Apps, 73
for colors, 61 Extensions
for fonts, 60 cfg, 54
for printers, 35, 78 for file names, 20
Default Windows shell, 10, 58
Deleting F
alarm settings, 43 L
layouts, 82 F12, default Hotkey for activating Dashboard, 12, 18
programs from layouts, 79, 82 F?xing, 35 .
Quick Launch buttons, 66 F¥1ename e.xtens.lons. See Extensions
Dialog boxes Flles,. opening with layouts, 80
exiting, 18 Floating toolbz.ir.s, 38-39
help in, 17 Fonts,' customizing, .60.
Directories Function keys, specifying as Hotkeys, 60, 72
assigning working, 67
choosing for installation of Dashboard, 2 G
Specifying for Quick Launches, 66 “Gas” gauge. See Resources
Disk space. See Hard disk space GDI resources, 40, 41
DOS command line, launching programs from, Grabbing items, 12
24-25, 67
DOS commands, entering from Dashboard, 10, 25 H
Double-clicking, 12, 49, 59
program groups, 27 Hard disk space, required for Dashboard
Dragging items, 12 for Windows, vi
Drivers, for sound generation, 3 Help button, 6, 7, 16
Drive Usage information, 42 Help featl?re, 16-17 .
Drive Watch, 6, 75-76 Help Hotline for Dashboard, vi
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Hiding
output devices, 77, 78
program groups, 63
Program menu, 13, 64
Highlight, moving, 18
Home key, 18
Hotkeys
for activating Dashboard, 12
customizing, 9, 59-60, 67
for extended screens, 34, 72
for floating toolbars, 39
for programs in program groups, 31
for Quick Launches, 66, 67
Hotline for help with Dashboard, vi

Icons
dragging to begin operations, 8-9
for printers, 77
for program groups, 30
for Quick Launches, 66
rearranging on Quick Launch panel, 9
specifying display of, 58
specifying to remain on screen, 9, 73
Installing
Dashboard, 2
printers, 36
sound, 3-4
Item lists for preferences, 48, 49

K

Keyboard, 18
See also Hotkeys

L

Landscape orientation, 77
Launching, Dashboard, 12, 18, 58
Launching programs
by dragging icons, 8-9, 21
from DOS command line, 10, 24-25
from Layout menu, 23, 81
from Program menu, 22

from Quick Launch buttons, 19-20, 65
using Alarm Clock, 23, 44
from within groups, 27
Layout menu, 6, 7, 23
Layouts
advantages, 79
for automating startup, 9-10, 79
creating, 79
editing, 80
loading, 23, 80, 81
saving, 34, 71, 79
versus configurations, 56
Loading
custom configurations, 55
data files, 20
layouts, 23, 80, 81
Load Layout command, 23
LPT ports, 35

Manage Layouts dialog box, 81-82
Maximize button, 6, 7, 13
Memory
checking available, 42
required for Dashboard, vi
required for Windows, 40
used by system resources, 40
warnings/alarms for, 40, 41, 74
Memory meter, 6, 7
Menus, exiting, 18
Messages. See Alarms
Minimize button, 6, 7, 13
Minimized icon, 6, 7
Miniwindows for programs, 6, 7, 32, 71
Modify Program Group dialog box, 64
Mouse
customizing click sequences, 9
how to use, 12
recommended for Dashboard for Windows, vi
specifying shorteuts for, 59
Moving
program groups, 29-30
windows, 12, 15, 26
See also Rearranging
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N

Naming, program groups, 64
New Program Group dialog box, 28

(0]
Opening

Dashboard for Windows, 2

DOS programs from DOS Command Window, 10
Orientation of printing, 77

P

Panels, priority of, 14
Paths
for program groups, 64
for Quick Launch programs, 66
Portrait orientation, 77
Ports, 35
Preferences
for customizing Dashboard, 48, 49, 57-62
See also Customizing
Printer Manager, 6, 7, 35-36
customizing, 77-78
as floating toolbar, 38, 39
Printer Manager Preferences dialog box, 77-78
Printers
customizing display of, 36
default, 35
installing, 36
viewing installed, 35
Printing, by drag-and-drop method, 9, 35, 37
Priority of panels, 14
Program Group Properties dialog box, 30
Program groups
adding programs to, 31
advantages of, 27
copying or moving programs within, 29-30
creating, 28-29, 63
groups within, 30-31
hiding, 63
synchronizing with Dashboard, 29, 63, 64
Program icon, 6, 7
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Program Manager, synchronizing program groups
with Dashboard, 29, 63, 64
Program menu, 6, 7, 22
customizing, 63-64
as floating toolbar, 38, 39
showing or hiding, 13, 64
Program miniwindows, 6, 7, 32, 71
Programs
cycling through open, 18
launching by dragging icons, 8-9, 21
launching from DOS command line, 10, 24-25
launching from Layout menu, 23, 81
launching from Program menu, 22
launching with Quick Launch buttons, 19-20, 65
Sticky Apps, 9, 73
switching, 10, 12
See also Program groups; Windows

Q

Question mark cursor, 17
Quick Launch buttons, 6, 7
copying, 20
creating, 9, 19, 65-67
launching programs using, 19-20, 65
rearranging, 9
sizing, 14, 20
Quick Launch panel, as floating toolbar, 38, 39

R

RAM, required for Dashboard, vi
Rearranging
Dashboard items, 49, 50-56
Quick Launch panel, 51
Quick Launch panel icons, 9
for vertical Dashboard, 15, 58
windows with extended screens, 34
windows with Task Manager, 10
See also Customizing; Moving
Reminder alarms, 43-45
Reread from Program Manager button, 29, 63, 64
Resizing. See Sizing
Resource Gauge, 6, 7, 40, 74-76



Resources
checking, 40-42
customizing display and warnings for, 74-76
displaying on title bar, 58

Resources dialog box, 41

Restore command, 13

Run dialog box, described, 10

S

Save command, 54
Save As command, 54
Saving
custom panel configurations, 53-54
layouts, 34, 71, 79
Screens
switching with Hotkeys, 9
See also Extended screens; Windows
Screen selectors, 6, 7, 33
Scroll arrows, 6, 7
Shell program, 10, 58
Shift key, 14, 18
for resizing panels, 51
Shift key combinations, as Hotkeys, 60, 72
Shortcut keys. See Hotkeys
Show Program Menu button, 6, 8, 22
Sizing
Printer Manager panel, 36
Quick Launch panel, 20
with Shift key and sizing border, 51
windows, 13, 14, 15
Sizing border, 6, 8, 51
Snap-off toolbars, 38-39
Snooze Interval, 45, 69
Sound
installing, 3-4
specifying for warning alarms, 41, 44, 74
Spacebar, 18
Startup layouts, 9-10
Sticky Apps, 9, 73
Switching
programs by clicking, 12
programs with Task Manager, 10, 26
screens with Hotkeys, 9
System environment information, 42

System menu, 6, 8
displaying, 18
System resources, displaying, 58, 74-76

T

Tab key, 18, 51
Table of contents for Help system, 16
Task Manager
for arranging windows, 10
specifying Dashboard’s in place of Windows’, 58
for switching programs, 10
viewing, 10
Task menu, 6, 8, 24
Technical support for Dashboard for Windows, vi
Tiling windows, 26
Time, displaying on title bar, 58
Title bar, 6, 8, 58, 71
Toolbars, 38-39
customizing, 62

U

Underlined menu commands, 18
Undo command, 48
USER resources, 40, 41

'}

Version 2.0 features, vii-viii
Vertical display of Dashboard, 15, 58

w

Warning indicator, 6, 8, 40, 41, 74
Windows
bringing to front, 12, 18
cascading or tiling, 26
minimizing or maximizing, 13, 14
rearranging with extended screens, 34
See also Extended screens
Windows shell, specifying Dashboard as, 10, 58
Working directories, 67
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Free Introductory CompuServe Membership

88

As a Dashboard customer, a free Introductory Membership to
CompuServe is yours for the asking. This Introductory
Membership includes:

* A Private User ID number and Password
* A $15 introductory usage credit
¢ A complimentary subscription to CompuServe Magazine

To obtain your free Introductory Membership, call
Representative 51 at:

(800) 848-8199 US and Canada

(614) 457-0802 outside the US and Canada
0800 289 458 UK only

0130 864643 German only

(44) 272 255 111 rest of Europe

If you are already a CompuServe member, type GO HPSYS to
access HP Forum.



CONVENIENT, PUSH-

BUTTON CONTROL
FOR EVERYTHING

YOU DO IN WINDOWS

If you have a need for speed and a craving for fingertip
control, Dashboard is the convenient push-button utility panel to

reach for,

With Dashboard, you can launch applications at the touch of a
key. Zip between them with ease. Switch between entirely differ-
ent extended screen setups instantly. Even monitor your memory,
resources and available disk space with the fuel gauge...It'sa ton
of mobility and convenience in just a little screen and disk space.

So, for the push-button control and one-click convenience you
want, and the speed you need, grab hold of Dashboard. The fastest

way to work in Windows.
D ] m FOR WINDOWS ]“‘
EXTENDED PRINTER
SCREENS MAMNAGER
Instantly switch between PROGRAM MENU Quickly switch from printer
applications in up to 9 full- Get fast access to all the to fax, reconfigure printers
SCreen views. applications in Windows or set default with a click.
\ Program Groups. 7
/
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Launch your favorite
applications, with the touc
ol a button.
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RESOURCE GAUGE
Monitor and control
memory, disk and system
resources.
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CUSTOMIZATION
ICoMN

Customize Dashboard to
display horizontally or ver- ‘
tically, with all its modules,

or just a few.



